—. ANGLO-AUSTRALIAN OBSERVATORY
P.O. BOX 296 EPPING N.S.W. 2121 AUSTRALIA
Telephone: +61 2 9372 4800 Fax: +61 2 9372 4880

2dF / 6dF CONFIGURE Usar Manual

: @' OroborOSX Launch Edit Options Window Help ¢ (®0(100% Thu3:54PM
i@ 3 Basic seguence Wy iy - - - s
SISE) e (00 Flestima o W/ |
Magnitude filter | Input lists are not b Fibre 184 (Spect_2)
Open file |/ {Users/ks/fposs/src/2 i g Al
= = —  Configuring 2dF (AAT) 3
Fbre combl & & 6 AAOD Fibre Configuration - 2dF {09/17/02)

Allocat Fle  view  Options  Commands  Zoom

BSave as 3[

Input File: | fUsersiksfipossisrcizdF_Test 1.fld
Exit
Field Name:| Fnal Analysis Sources in ELAIS-51
UT Date:| 2002/07/07  Time: |  19:36:06

Config Wavelength: 6000.00

Field Centre (J2000): RA: | 00 34 37.20 Dec:l -43 28 12.0

Plate: [0 HA: [ -00:00:00  z0: [ 12:10:25
-1 Guide Allocation statistics Available targets
i SpectA  Fibre type Total Sky Objects  Unalloc | Ohbjects Skies
= Bylpriol Guide 4 0 4 0 28 0
Spect 1 200 19 143 38 57 3
_i By allogi
| Spect 2 200 17 144 39 57 3
Ta Totals | 404 36 | 291 77
Messages

[14:33.12 Opened telescope model file "/Users/ks/fposs/src//tdFdisto
14:33:12 Opened telescope model file "/ Users/ks/fposs/src//tdFlines

14:33:12 New field plate is O
14:33:16 Initial File:
Apply |14:33:33 UT set to 2002/07/07 19:36:06 to put field on meridian

15:42:13 Doing allocation for field O
15:43:47 Allocation completed in 24 seconds.

=




Fibre Positioner Page 2 of 62
AA O 2dF/6dF CONFIGURE User Manual Issue 1.1, 12 Mar 2003

Author(s)

KS  Kaeith Shortridge, AAO.
CR  ChrisRamage, AAO.

Change Record
Issue/ Date By | Section/ Reason / Remarks
Revision Page affected
1.0 30/09/2002 | KS | All First 2dF/6df Issue
11 12/03/2003 | CR Allow objects to be assigned to

specific spectrographs.
Various miscellaneous bug fixes and
cosmetic changes.




Fibre Positioner Page 3 of 62
AA O 2dF/6dF CONFIGURE User Manual Issue 1.1, 12 Mar 2003

1

w N

5

2dF / 6dF CONFIGURE User Manual

Contents

g1 oo [FTox 1 o o S 5
O T o U070 PPV 5
S 0T o RPN 5
1.3 ADbDreviations and ACIONYIMS........couiiiiiiririeeeie et re e b s enens 6
IR0 S N\ 00T o = = SRR 6
ST o o U = USSP 6

(@< V= T TS 6

Changes from PreViOUS VEISIONS.........coveiiieriereriesiesie et see e e s s e s e e 7
T RISV (= 1451 U] o0 1= o SRS 8
3.2 FIDIEEYPES ...ttt e b b r e nneene s 8
3.3 BaSiC SEQUENCE WINUOW .......coiiieieiieeieeie ettt sttt ee s et neesreeseesneesseeee s 8
3.4 AllOCELION SEALISHICS. ... veveeieeiieieie sttt bbbttt se et bbb sae e eneas 8
3.5 Target SHECtiON PANEL .......cceiiiie e nre s 8
3.6 FIDretype SEIECHION. ......ccue e et nae s 9
G AV F="o a1 (8o (= 1L S 9
OIS TS (G 2 O NN I 1 TSRS 10
3.9 Speed and agorithmiC ChaNGES .......cociiiiieee e 10
3.10 Allocation of targetsto a particular Spectrograph...........cccevvevevieveece s 10
3.11 Control of which Fibresare used for SKY........ccooviiiriiiiieee e 10

USING CONFIGURE ........ccoiiiiiicieiieiee ettt st b e e stesaesreeneene e 10
A1 INitial PreparatioNS........cccceieereee e e eee s e se e te e sreete e e s seeseeseesreenreeneeaneereas 10
4.2 Preparing the INPUE FITE ..o 11
4.3 RUNNING CONFIGURE.........coiiiiiiiitieie ettt nne s 12
4.4 Reading iN atargel file. ... 13
4.5 Specify the fibre ComMDINGLION...........ooiiiiii e 13
4.6 Perform the @lOCaliON ..........cooiiiiiiiieee e e 13
4.7 Saving the CONFIQUIALION. ........ccoiieiecie et ae e sreenneaneeas 14
4.8 EXITTNE PrOGraM ....coveiiiiiecteeie ettt ettt nb e se e sbeesbe st e sreenaeaneaas 14
4.9 AdAItIONal CNECKS ... oottt b et eesreesaeenee s 14

Some additional TEAIUIES .........c.coiiieieieri e 16
5.1 USINgthe MimiC WINUOW ........ooiuiiiiieiie ettt ettt s esaeenree s 16
5.2 Different alocation algorithms..........cceiiieiiiiiie i 16
5.3 UNCIOSSING fIDIrES......eoeiee ettt ne e 16
5.4 Multiple configurations to cover atarget liSt.........ccoooerieeiii e 17
5.5 Viewing alocations USING SKYCEL..........ccccveiuiiiiieeiie ettt 17

Detailed inpUE filE@ TOMMIEL .........ooiiieeee e e 19
6.1 Additional items embedded in COMMENES .........ccoeiiiieiiiiiee e 20
6.2 POSSIDIE ODJECE LYPES:.....ee ittt ere e 20
6.3 Example TeXt INPUL FilE ... 21

The CONFIGURE PIrOQIraM........cciieiiieeiieeiieeseeesieesaeasieesesssseesseseseesseesssesssassnseesssesnsenss 22
7.1 Running the FLAMES configuration Program...........cccceeeceeiieeeseeseesseeseeesseeseesnseens 22
7.2 OPENING FIES......iiiiie bbbttt ne bbb e 22



Fibre Positioner Page 4 of 62
AA O 2dF/6dF CONFIGURE User Manual Issue 1.1, 12 Mar 2003

7.4 Setting the Wavel @NgtN.........coeii e 23
7.5 Settingthe FIald PLale.......ccoooece et 24
7.6 Overview of the AllOCation ProCeAUIE..........ccceieeieeenieseeie et 24
7.7 TheAllocation Procedure in detail ...........ccooeeiiiieninieniesee e 24
7.7.1 The'OXford agorithm .........cccoi i 25
7.7.2 The'Taylor algorithm ... 26
7.7.3 Tentative deallOCALION.........coiieieeieseee e 27
A T o (=W s 10755 ] o S 27
T7.7.5  SKY BlIOCEIIONS......cooiuiiiiiiieiieeeee et n e sne e 27
7.8 TarQEt PrIOMTIES . ....ceiiiieieieee ettt nb e nn e 28
7.9 The aloCation WINAOW .........cooiiiiiiiiesiisiesesee e 28
80 O S QT 1 = U 28
7.11  Manual AlOCation Of FIDIES........coviiiiieiee e e 29
712 The MimiC DiSPlay ...cceceeieeee ettt st nns 30
7.13  Saving @ CONfIQUIELTION. ......coceiieriieieeie sttt sr e e sreeneenns 30
48 S = T (o 1Y/ oo [ TR 31
7.15  Command Ling SWItChES........ccooiiiiiiie e e 31
8 Obtaining and installing the Program ... e 33
9 TheMeNUSIN AELAI .........cooieeeie e 34
0.1 TREFIEMENU ..ottt bbbt bbb 34
0.2 TREVIBW MBINU ..ottt sttt ettt ettt e s s e be e e e sbe e teeneesseenseeneesseeseenee e 35
0.3 ThE OPUIONS IMEBNU......ciiiieiieee ettt st be e e sreesreenne e 36
9.4 The ComMMANTS IMENU .....c.coiiiiiiriee ettt bbb 36
0.5 ThE ZOOM MENU.....oiuiiiieiieie ettt s be et et e b et e eneesre e e e 39
O T o= 1Y oo L= PSR 39
10.1  INVOKING EXPEIT MOUE........ceieeieeiesieeieeeesteesteeee st etesee e sesseesseeeesneesseeneesneenseeneas 39
10.2  MenUSIN EXPEIt MO ........oiieieeiiieesie ettt ne e 40
10.2.1 The Filemenu in eXpert MOE.........cccceieeiiriie e e 40
10.2.2 The View menu in eXPert MOE ........ccceveereeeeieese e e 41
10.2.3 The Options menu in eXPert MOE ..o 42
10.2.4 The Commands menu in eXPert MOCE..........cccuveerierreneeneeie e 43
10.3 TheAllocation Dialogue in EXpert MOde.........ccccoveveeieieeneeie e ee e 45
11 Appendix A: A tour of CONFIGURE..........ccooiiiiiieiee e 47
0 RS = 1 1T T o USROS 47
11.2  Setting amagnitude filter ........cveiiieceee e 50
11.3  Opening the datafile.........cooeeiiree e 51
11.4 Selecting the Fibre combination............cccoooeeieiiic i 55
11.5 Performing the AHOCEHION .........cccvieeciee e 56
116 Savingthe allOCatioN ..........coce i 58
11.7  Thingsnot in the DaSIC SBAUENCE..........cccuieiie ettt 59
11.7.1 Changing the central wavelength ...........cccccveivieri e 60
11.7.2 Checking AlOCatioN Validity .......ccoouviiieiieciie e 60

12 Appendix B —BUQ rEPOMING ......ocoveeiiieiieecie ettt re e s e sneeenne e 62



Fibre Positioner Page 5 of 62
AA O 2dF/6dF CONFIGURE User Manual Issue 1.1, 12 Mar 2003

CONFIGURE User Manual
1 Introduction

This manual describes the CONFIGURE Fibre configuration program written at AAO,
originally as part of the 2dF project. It takes as input a file containing a list of target objects
and generates a configuration in which as many fibres as possible are alocated to targets,
allowing for the various instrumental constraints and any specified target priorities. It
produces a file containing a list of alocations of fibres to targets. This file needs to be
supplied to the instrument software so that it can configure the instrument according to this
predetermined configuration. CONFIGURE has been adapted to handle other similar
instruments, namely the AAO’ s 6dF system and ESO’s FLAMES instrument.

CONFIGURE is available in a separate version that only supports FLAMES. This version is
known as FPOSS, and has its own manual, similar to this, but which describes the use of the
program in the context of the ESO observation preparation system. The manual you are
reading now is designed for people using either 2dF and 6dF, using the version of the
program, CONFIGURE, that supports al three instruments. It is unlikely that you will
actually want to use this general-purpose version of CONFIGURE to configure FLAMES. If
you do, you should be reading the FPOSS manual. This CONFIGURE manua does not
attempt to cover the details of FLAMES configurations.

CONFIGURE is run as a standalone program on the observer’s own computer system, or at
AAQ. Itisavailable from AAQO in versions suitable for Linux, Solaris, and MacOS X.

This manua begins with a brief summary of how to use the program, aimed at 2dF/6dF
observers. Thisis followed by a detailed formal description of the input text file format. The
sections after that present a more formal description of the configuration program.

An appendix contains an introductory tour of the program, taking you in detail through an
allocation from the reading of a supplied input text file to the writing of the output SDS file.
You may like to run through this when you start to use the program, just to get familiar with
the way it works. The appendix provides little that cannot be found in the main body of the
manual, apart from a number of illustrations, but some users may find this the most
convenient introduction to CONFIGURE.

1.1 Purpose

This document serves as the User Manua of the CONFIGURE fibre configuration software.
It has been written for operators of the instrument and astronomers. The reader is assumed to
be familiar with whichever of the 2dF or 6dF instruments they intend to use.

1.2 Scope

This manual only covers the operation of the CONFIGURE program itself. It does not cover
the any of the details of observing with 2dF or 6dF. It does not cover use of CONFIGURE for
use with the FLAMES instrument in sufficient detail to serve as the manua for FLAMES
configurations.
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1.3 Abbreviationsand Acronyms

The following abbreviations and acronyms are referenced in this document:

2dF The AAO’s 2 degree Field Facility, used at the AAT
6dF The AAQO’s 6 degree Field Facility, used at the UKST
AAO Anglo-Australian Observatory

AAT Anglo-Australian Telescope

FACB The ESO term for a guide fibre

FLAIR The 6dF spectrograph

FLAMES The ESO VLT Fibre Facility

FP Fibre Positioner

FPOSS The version of CONFIGURE specific to FLAMES.
GUI Graphical User Interface

gzip/gunzip Standard UNIX file compression/expansion utility programs.
PAF Standard file format for VLT internal files

SDS Standard file format for AAO interna files

Tcl Tool Command Language

Tk Tcl Windowing Toolkit.

UKST United Kingdom Schmidt Telescope

VLT Very Large Telescope

Page 6 of 62
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1.4 Nomenclature

Throughout this manual the term ‘reference star’ is used for a target that is intended to be
allocated to the guide fibre bundles. The term ‘guide star’ is only used for a star intended as a
target for the VLT guide probe, something that only concerns observers using the FLAMES
instrument, who should not really be using this manual. Earlier versions of this manual, and of
the program, used the terms ‘reference star’, ‘guide star’ and ‘fiducia’ more or less
interchangeably.

1.5 Figures

As with all UNIX programs, the detailed appearance of windows depends on the window
manager being used, so when you run the program it may not look exactly as it does in the
screen shots in this document. The screen shots in this document are from a mixture of
systems. Some are from the OroborOSX window manager on a MacOS X system. Others are
from the PC-Xware NCD window Manager displaying configure running on a Solaris 2.6
system. All the illustrations were made running CONFIGURE in its 2dF mode. In 6dF mode
it looks amost identical, except for the number, distribution and size of fibres in the mimic
display, and the fact that 6dF only has the one spectrograph, so has only guide fibres and 6dF
fibres.

2 Overview
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The configuration program is part of the observation preparation software used by a number
of instruments built by the AAO. These include the original '2dF, the more recent '6dF and
the 'OzPoz' fibre positioner built for the 'FLAMES' instrument for ESO. All of these
instruments use a robotic fibre positioner to place optical fibres in the focal plane of the
telescope so that light from a number of target objects may be fed to spectrographs or other
instruments. These all need a configuration phase in which the fibres are allocated to targets
in such a way that the fibre configuration is physically possible (fibres and the 'buttons' that
carry them do not collide, and fibres are not bent past their allowed tolerances, for example),
and the best coverage possible is achieved (as few unallocated targets as possible, without any
strange artifacts in the distribution of allocated targets, for example).

A version of this program is distributed by ESO as an adjunct to the P2PP process for
FLAMES, and this version of the program is known as FPOSS (Fibre Positioner Observation
Support Software). The version distributed by AAO is capable of configuring any of the three
supported instruments, and this version, called CONFIGURE, is the version described in this
document.

The role of the configuration program (CONFIGURE) isto take a text file containing alist of
target objects and to allocate fibres to these in as optimal a way as possible. It then writes out
afile giving the details of the resulting configuration. When 2dF or 6dF is being configured,
this file is written out in the AAO’s Structured Data System file format (SDS), and has to be
supplied to the observing software when the observation is set up.

Therest of the manual is organised as follows:

Chapter 3 describes some of the changes made for the current version.
Chapter 4 summarises the use of CONFIGURE for 2dF/6dF observers.
Chapter 5 describes some more advanced features of the program.

Chapter 6 provides information about file formats.

Chapter 7 provides comprehensive descriptions of program facilities.
Chapter 8 gives details about obtaining and installing the software.

Chapter 9 provides menu guides and explanations.

Chapter 10 describes the additional options availablein ‘expert’ mode.
Chapter 11 is an appendix that provides an illustrated tour of CONFIGURE.

3 Changesfrom previous versions

This section is designed for users who are familiar with previous versions of CONFIGURE.
When CONFIGURE was modified for use in 2002 with the ESO FLAMES system, it was
fairly comprehensively overhauled, and as a result users will notice a number of differences
between the latest version and earlier versions. There are also a number of differences that
may not be immediately obvious, but which are important, nevertheless. (And, of course, any
comprehensive overhaul of a piece of software will usually fix many bugs but will also
introduce new ones. Please report any you find to cr@aaocbn.aao.gov.au. Y ou should read the
brief appendix on bug reporting, section 12, first.) The following sections highlight some of
the main changes.
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3.1 Systemssupported

The new version supports 2dF, 6dF and FLAMES. The initial dialogue box that comes up
when the program is first run alows you to select which instrument is to be used. Note that
once you select an instrument you cannot change to another instrument other than by exiting
the program.

3.2 Fibretypes

The way fibre types are handled has been completely revised for the new version. Thisisvita
for FLAMES, which has a number of different fibre types, not all of which can be alocated at
the same time. For 2dF/6dF which distinguish only between guide fibres and spectrograph
fibres, and (for 2dF) between the two spectrograph fibres, it is less important, but may still be
useful. For example, for 2dF you can specify how sky targets are to be distributed between the
two spectrographs. This emphasis on fibre types can be seen in a number of the changes listed
in this section.

3.3 Basic sequence window

The basic sequence window that attempts to guide you through the steps of a basic
configuration is new. It has its origins in the requirements for the ESO FLAMES instrument,
which has quite a complex basic configuration sequence including the need to select a VLT
guide star. For 2dF and 6dF use it may not be quite so useful, but it does provide a convenient
location for some of the common controls needed — such as the ‘Allocate’ button. It also
provides a convenient feedback in some cases — it provides the most convenient display of the
total number of fibres allocated, for instance. There is nothing available in the basic sequence
window that cannot be found in the menus of the main control panel. If you think it getsin the
way, the best thing to do is minimise it and forget about it.

3.4 Allocation statistics

The main control panel now displays allocation statistics separately for each fibre ‘type’. For
FLAMES, which has a number of different fibre types, this is important. For 2dF, where the
fibre types are only ‘guide’, ‘spectrograph 1’ and ‘spectrograph 2', and for 6dF which only
distinguishes between ‘guide’ and ‘ spectrograph’, this is less important, but it may be useful.
It also displays the number of available targets for each fibre type. Note that any unallocated
non-guide target within the field can potentially be assigned to either spectrograph, so is
included in the total for each fibre type.

3.5 Target selection panel

This panel appears when the ‘ Select targets’ option in the ‘View’ menu is selected. It provides
ameans of highlighting targets that meet various criteria, such as allocated/unallocated, target
type, priority, etc. Thisisshown in Figure 1.



Fibre Positioner Page 9 of 62
AA O 2dF/6dF CONFIGURE User Manual Issue 1.1, 12 Mar 2003

Select targets to highlight

I 0 Targets selected

1 Guide I Sky

.1 Program 1 Spect 1

.1 Spect 2

_i By priority: l_ to E_

i By allocation: # Allocated - Unallocated

Target scale factor: FE' Hedrawli

I Highlight using arrows

[__HFE_ Clear | Close |

Figure 1 The'Select targets pand

.

The *highlight using arrows’ option is useful when there are a large number of targets — it
makes the selected objects stand out quite dramatically.

3.6 Fibretype selection

The options menu now has a ‘ set fibre combination’ entry which allows you to select one of a
number of pre-defined fibre combinations. In most cases for 2dF/6dF, the default *all fibres
option is probably the one required. It really only becomes important if you want to
distinguish between the two 2dF spectrographs.

3.7 Magnitudefilter

There is a magnitude filter dialogue that allows you to specify that only targets within a given
magnitude range are to be included. Targets in the input file outside that range are ignored
(with the exception of guide targets). This alows you to have a large number of possible
targets in a field and to produce a number of configurations that cover these in specified
magnitude bands.



Fibre Positioner Page 10 of 62
AA O 2dF/6dF CONFIGURE User Manual Issue 1.1, 12 Mar 2003

3.8 SKYCAT lists

The ‘list’ option in the file menu now provides an option for output in a format that can be
read into the ESO ‘skycat’ program. It is now easy to read this file into skycat and see the
targets displayed over an image of the field. For more details see section 5.5.

3.9 Speed and algorithmic changes

The agorithms used by the configuration program have been revised and modified. The
‘swap’ phase of the ‘iterative’ algorithm traditionally used by 2dF/6dF, particularly for the
redshift survey, now examines a large number of potential swaps that were being
unintentionally omitted by the previous implementation of the algorithm. The result is that
that iterative algorithm now produces configurations with significantly more fibres allocated.
This is, however, a the expense of the time taken, which has increased, particularly when
there are a large number of targets in the field. The program is now much more responsive
during the swap phase, alowing the alocation to be cancelled easily if it istaking too long.

3.10 Allocation of targetsto a particular Spectrograph

For 2dF, it is now possible to specify in the input file that a program object may only be
allocated to a particular spectrograph.

3.11 Control of which Fibresare used for Sky.

A new expert mode option has been added to allow the user to specify the minimum and the
maximum fibre numbers that may be automatically allocated to sky targets. This was added to
allow for a specific program that required sky targets to be located toward the center of the
CCD chips.

4 Using CONFIGURE

This section provides a description of how 2dF observers should use CONFIGURE to prepare
configuration files. This section attempts to be brief; more details can be found in the rest of
the manual. If this section seems too brief, or if you have problems running the program with
your own files, you should try following the detailed tour in chapter 11 in order to become
familiar with the program.

4.1 Initial preparations

Y ou need to know the following things:
*  Whereyour target field is. Y ou need to know:

A central position, preferably in J2000 coordinates.
A name for thefield.
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The name can be anything you choose. You can modify the field centre position
dlightly in CONFIGURE, but you need a good initia position.

* When you intend to observeit.

Y ou need to specify aday. You probably don’t know this exactly, but you can make a
reasonabl e guess.

* What targets you want to observe. You need alist of targets, and for each one you need:

A name.

The position, preferably in J2000 coordinates.
The magnitude.

Thetarget type.

A priority.

The magnitudes are recorded in the output files, but are otherwise ignored. Targets of
high priority are alocated to fibres in preference to ones of lower priority. Priorities
are classified as a numeric code from 1 to 9, with 9 the highest priority. The target
type determines what fibre types can be assigned to the target, so you need to know
which targets are to be observed with which instrument. For 2dF/6dF, guide fibres can
only be allocated to guide targets. Other fibres can be allocated to any program object.

e Thelocations of some reference stars

You also need to supply a number of stars that can be used as reference objects by the
guide fibres. At least three of these need to be included in the configuration, so you
should supply a number of possible reference stars, arranged throughout the field.

* Some sky positions

Y ou can handle sky in more than one way, but the most control over sky is obtained by
providing explicit sky targets — coordinates that refer to blank sky — in the target list.
Alternatively, CONFIGURE can generate a ‘sky grid’ of possible sky positions, but it
cannot guarantee that these actually represent blank sky. However you allocate sky
targets, you should ensure that your configurations have enough sky targets allocated to
fibres.

4.2 Preparingtheinput file

Most the information listed in the previous section needs to be supplied to CONFIGURE in a
text file. Such files are usually called *.fld" files, since that is the usual extension that they use.
These can be created using an ordinary editor, but it is more likely that the bulk of the file will
be created using a program. The format of the file is detailed in section 6 but it has a short
initial section describing the field itself and then a series of lines each one of which describes
one target object. (Some of which describe reference stars and some of which describe sky
positions.)

Thefield details at the start of the file might look like this:
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LABEL 2dF test field

UTDATE 2002 07 07

CENTRE 00 34 37.20 -43 28 12.00
EQUI NOX J2000. 0

And the following might be lines describing individual targets:

FO2 00 30 42.62 -43 47 02.11 F 9 13.65 0 fiducial star
FO3 00 31 39.02 -42 48 01.75 F 9 13.74 0 fiducial star
Fo4 00 32 16.06 -43 51 05.29 F 9 13.64 0 fiducial star
FO5 00 32 20.19 -43 01 41.91 F 9 13.40 0 fiducial star
OBJECT_01 00 29 30.66 -43 11 41.24 P 9 21.32 0 #11
OBJECT_02 00 30 39.74 -42 53 49.42 P 9 20.65 0 #22
OBJECT_03 00 31 23.87 -43 09 40.77 P 9 19.71 0 #27

sky-01 00 29 42.33 -43 19 31.72 S 8 99.9 0 blank sky
sky- 02 00 29 51.85 -43 49 40.91 S 8 99.9 0 blank sky
sky- 03 00 29 57.31 -43 03 26.69 S 8 99.9 0 bl ank sky
sky- 04 00 31 51.59 -43 56 06.00 S 8 99.9 0 blank sky

Each of these sample lines describes atarget of a given type, distinguished by the single letter
target type code that follows the coordinates. ‘P is a ‘Program’ object — a target that can be
assigned to any spectrograph , ‘S is a sky position, and ‘F is a reference star target (a
‘fiducial star’) for the guide fibre bundles. For 2dF, program objects may aso be described by
atwo letter code. 'P1' is a Program object that may only be assigned to spectrograph 1 and 'P2'
isaProgram object that may only be assigned to spectrograph 2.

It is possible to generate a number of configurations from the same input file. If you intend to
observe the same field with different combinations of fibre types you can include the targets
for al fibre types in the one file and generate different configurations with different fibre
types enabled. Thisis probably not alikely option for 2dF/6dF. If you have alarge number of
targets in the same field you can put them all in the one file and generate a number of
configurations until all the targets have been allocated.

4.3 Running CONFIGURE

Y ou obtain a copy of the various files needed by CONFIGURE from AAO, and install them
in adirectory on your local machine. Where you choose to do that is up to you. Note that it is
very important to have the latest versions of the various instrument files, and that for 2dF
there are a number of different calibration files that depend on the declination of the target
fields. Make sure you have the appropriate files. For more details see the AAO 2dF web site.
For smplicity here, we assume the directory containing all these isin your execution path, so
just typing the name of an executable file in it will run that program. The CONFIGURE
executable is called ‘configure’. The most convenient way to run it is probably to have a
working directory in which you have your .fld files and in which you will generate your
configuration files. With your default set to that working directory, type

configure &
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This will start up CONFIGURE. There is a standard basic sequence that will guide you
through the steps needed for a standard configuration. The basic sequence window is shown
in Figure 13, and a configuration can be created and saved ssimply by clicking its buttons in
order. (The tour through CONFIGURE in the appendix - section 11 - shows the user interface
in detail as one follows this sequence.) Essentialy, you have to do the following:

Set amagnitude filter to reduce the number of targets read from the .fld file, if necessary.
Read in the details of atarget field from the .fld file.

Optionally specify the fibre combination to be configured.

Perform the allocation of fibres to targets.

Save the resulting configuration in an SDSfile.

Each of these steps corresponds to one button in the basic sequence window.

4.4 Readingin atarget file

The program has no preset limit to the number of targetsit can handle, but in practice it starts
to run slowly (particularly when displaying) if it is dealing with more than a couple of
thousand targets. Some of the allocation algorithms, particularly the ‘iterative’ agorithm,
become extremely slow with more than a few hundred unallocated targets. If you have too
many targets in your input file, you should apply a magnitude filter so that only targets in the
same magnitude band are handled at one time. (The filter does not apply to reference stars.)
To apply a magnitude filter, click on the ‘magnitude filter’ button in the basic sequence
window and enter apair of limiting magnitudes. Then click on *apply’.

To read in atarget file, click on the ‘open file' button in the basic sequence window. Then
select the file (usually a .fld file) in the file selection dialogue. The field will be displayed,
together with all the fibres.

4.5 Specify the fibre combination

Click on ‘Fibre combination’ in the basic sequence window. A list of possible fibre
combinations appears. You should select the one you want to use and click ‘apply’. The
default is*all fibre types', including guide fibres, and thisis usually what is needed for 2dF or
6dF.

4.6 Perform theallocation

Click on the ‘alocate’ button in the basic sequence window. A dialogue window appears
offering you various options that control the details of the allocation process. Usudly, the
default values will be fine, and all you need to do is click the *OK’ button. Y ou should check
the number of sky targets that are to be alocated. If you are using fibres that can be allocated
to either sky or non-sky targets it is usualy best to tell the program explicitly to allocate a
certain number of sky targets to each fibre type. If you have too few sky fibres allocated you
may not be able to get the best out of your data when you reduce it.

Section 7.9 provides more details of the allocation process and explains the various options.
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The total number of fibres alocated is shown in the basic sequence window. More details,
including the number allocated to reference stars and to sky targets are shown in the control
panel. Y ou should check that you have enough sky and reference targets allocated to fibres.

If the allocation is unsatisfactory for any reason, you can try again with different parameters
(in which case you should select ‘remove allocations' from the ‘commands menu first). Or
you can make minor corrections to the allocation by hand, selecting targets and fibres by
clicking on them and either explicitly allocating or deallocating them. This is described in
more detail in other parts of this manual.

4.7 Saving the configuration

Click on the ‘Save as SDS' file button in the basic sequence window. A file save dialogue
will alow you to specify the name and location of the file to be written. The default name for
the fileis generated automatically from the name of the input .fld file. Thisfileisabinary file
and it is not practical to try to modify it other than by reading it back into CONFIGURE. If
you need to e-mail such afile of transfer it using FTP you should ensure that it is transferred
asabinary file. In general, before transferring these files you should gzip it first, then transfer
the gzipped file and gunzip it on the receiving machine.

Note: The program will not allow you to save a configuration for which there are fewer than 3
three guide stars allocated. This is a safeguard to ensure that you do not forget to allocate
guide stars for your observation. If you really want to save a configuration with fewer than
three alocated guide stars, you can do so if you switch the program to ‘expert’ mode first.

4.8 Exit the program

Click onthe ‘Exit’ button in the basic sequence window to exit the program.

4.9 Additional checks

The basic sequence described above will usually generate perfectly satisfactory
configurations. However, you may want to perform some additional checks yourself.

Changes in central wavelength and hour angle introduce small changes in the position of
target objects in the field. CONFIGURE configures its fields for a specific hour angle and
central wavelength. If the actual observation is made under radically different circumstances,
the target positions will change and in some circumstances these changes can result in two
fibres being positioned too close together, or the maximum bend angle for a fibre being
exceeded. CONFIGURE allocates using more restrictive tolerances for such things as
button/fibre clearances and maximum fibre bend angles than does the actual positioner. This
means that configurations generated by CONFIGURE should be valid over a wide range of
hour angles and various central wavelength values. Allocations that are performed by hand
use the same tolerances as the positioner. This means that manually allocated fibres are
potentialy less tolerant of changes to the central wavelength or hour angle than allocations
that are performed automatically. Y ou may wish to test your field. Y ou can change the central
wavelength using the * Set Wavelength’ option in the *Commands menu, and can then check
the validity of your fibre allocation a this new wavelength using the ‘Check Allocation’
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option in the ‘Commands menu. Y ou can check the validity of the allocation over a range of
hour angles using the * Check over HA range’ option in the ‘Commands menu.
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5 Some additional features

This section describes in a relatively informal way some of the additional features of the
program.

5.1 Usingthe Mimic window

A number of features are available as you move the cursor around the mimic window. Some
of the more useful are as follows:

Y ou can zoom in and out using the ‘zoom’ menu in the main panel, but you can also zoom in
by a factor two by clicking the right mouse button in the mimic window. Y ou can zoom out
by afactor two by control-clicking the right mouse button in the mimic window.

As the cursor moves over a fibre, the fibre number and type are displayed a the top
information pane of the screen. If you click on a fibre, this selects the fibre. As the cursor
moves over a target, the target name and type are displayed at the top of the screen. If you
click on an unallocated target, this selects the target. (It's hard to click on an allocated target,
because the fibre covers it and you select the fibre instead. In practice, however, you rarely
want to select an allocated target — selecting the fibre is usually what you want to do.)

If you have selected an unallocated fibre and an unallocated target, you can use the ‘allocate
target’ option in the ‘commands menu to allocate the selected fibre to the selected target. (Or
you can use the ‘F3’ key instead.) If you have selected an allocated fibre, you can use the
‘dedllocate fibre’ option in the ‘commands’ menu to deallocate it. (Or you can use the ‘Del’
key instead.) This allows you to impose your own choice of alocations if you really want to
do so.

5.2 Different allocation algorithms

The program supports a couple of different allocation algorithms, and these can all berunin a
number of different ways. These are controlled by the options presented to the use by the
dialogue box displayed when the * Allocate...” option is selected. These are described in detail
later in this document.

5.3 Uncrossing fibres

It is possible to explicitly invoke a version of the allocation agorithm than only attempts to
reassign already allocated fibres in order to reduce the number of crossovers of fibres. This
can be done by selecting ‘uncross fibres...” from the Commands menu. The fewer
crossovers there are in a configuration the faster it is for the fibre positioner to reconfigure the
field.
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5.4 Multiple configurationsto cover atarget list

If you have a large number of targets then you may want to try to create a number of
configurations that will cover al of the targets. The program is not optimised for this mode of
operation, but it can be used in this mode.

After afirst configuration, which will, of course, only have alocated fibres to a small subset
of the targets available, select the ‘List...” option from the ‘File menu. A dialogue box will
allow you to control what is output to the list file. Select the ‘unallocated objects option.
Thiswill produce a new target list that contains only the unallocated targets and the reference
targets. (All guide fibres are included, even those allocated in the present configuration, since
they can sensibly be reused in the next configuration.). Y ou are then prompted for the name
and location of the new list file.

Y ou can then select the ‘Open..." option from the ‘File’ menu and specify this new target list
as the input file. You now have all the targets except for those non-guide targets allocated in
the previous configuration. Y ou can create a new allocation and repeat the process.

(Thiswill get tediousif exhaustive coverage is needed —i.e. if the intention isto cover all the targets in the input
list — and the final configurations will have relatively few targets. The tediousness can be addressed by
automating the procedure if this is going to be useful. These are aspects that need further discussion based on
experience with the program.)

5.5 Viewing allocations using Skycat

Y ou may want to see the allocated targets plotted against an image of the sky. In particular, if
you have sky targets you may want to check on whether or not these really do represent blank
sky. CONFIGURE can generate catalogue files in the standard ESO catalogue format
containing all the allocated targets, and these can be read by the ESO SKY CAT program.

To do this, select the ‘List...” option from the ‘File’ menu, and select the ‘Allocated objects
in Skycat format’ option from the dialogue box that comes up. You are then prompted for
the name of the catalogue file to be written.

If you now run Skycat, you can read this newly created catalogue file as alocal catalogue file.
(Use the menu sequence Data-Servers -> Local Catalogs -> Load from file.) If you do so
immediately after running Skycat, with no image displayed, Skycat will default to a display
centered on the center of the field that was alocated, and will show some of the allocated
targets around the center of the field. To get the allocated objects displayed on a sky image,
use the ‘Image servers' sub-menu. (The usual menu sequence is. Data-Servers -> Image
Servers-> Digitized Sky at ESO.) The center of the field will aready be set, but you should
increase the size of the field to be somewhere in the range 25 to 30 arcmin, depending on how
much of the field you want to see. An image will be retrieved from the image server, and will
be displayed with the allocated targets superimposed on it.

By default, sky targets will be displayed as white squares, reference stars (guide fibre targets)
will be displayed as white diamonds, and al other targets will be displayed as white circles.
Skycat experts can change these defaults. The catalogue as written by CONFIGURE contains
atext entry that describes the target type precisely, and numeric entries that indicate whether
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or not each target is a sky target or a reference target. There is one dummy target included in
the catalogue, the first one listed, that indicates the center of the field.
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6 Detailed input file format

This section refers to the text file that is used the first time a set of targets are presented to
CONFIGURE. Usudly these are files with a .fld extension, athough that is not necessary.
These files are prepared by the astronomer — possibly using a purpose-built program to do so.

The file consists of lines of up to 256 characters. Comment lines can be indicated by an
asterisk character (‘*’) or a hash character (‘#) in the first column. At the start of the file,
there should be a series of lines that describe the field itself, as opposed to the individual
targets it contains. Special characters, particularly quotes, should be avoided. Each of these
lines must begin with one of the following keywords (which may appear in any order):

LABEL A string giving the target field label.

UTDATE The UT Date of observation.

CENTRE Field Centre R.A. and Dec. (hh mm ss.ss-dd mm ss.s)
EQUINOX Coordinate equinox — eg. J2000.0

ARGUS Argus angle and scale values.

Any non-comment line that does not start with one of these keywords will be assumed to
signal the start of the target list. The ARGUS line is meaningless for 2dF/6dF, referring to a
feature of the ESO FLAMES instrument, and is ignored if that instrument is not being used.
The equinox of all coordinates given in the file must be that specified in the EQUINOX line.
The EQUINOX lineis optional and if omitted defaults to J2000.0.

LABEL can befollowed by any text. It does not have to be enclosed in quotes.

UTDATE must be followed by the date in the format yyyy mm dd[.dd]. The fractional date
shown here as [.dd] indicates that atime of day can be included as a decimal fraction of a day.
CENTRE must be followed by an RA and Dec in the format hh mm ss.ss[-]dd mm ss.s. The
[-] indicates an optiona sign.

EQUINOX, if supplied, must be followed by the string J2000.0. For FLAMES the use of
J2000.0 is mandatory — other instruments allow other equinox values to be specified.

ARGUS, if supplied, must be followed by a position angle in degrees and a string specifying
the ARGUS scale. The scale string must be either *1:1" or ‘1:1.67" (the quote characters are
not required). Note that thisis not relevant to 2dF or 6dF.

Subsequent lines describe target objects, one per line. Each line consists of a number of items
separated by spaces. Thefirst four items are mandatory as follows:

Name The name of the object (by convention F<n> isused for
reference stars) Note that this cannot contain spaces.

RA (hh mm ss.s9)

Dec (-dd mm ss.s)

Type One character indicating the type of object. The allowed types
arelisted below.

Priority (1-9) with 9 being the highest priority. If you are not using

priorities you should set all priorities to the same value, say 1.
Magnitude (mm.mm)
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Program Id An integer which uniquely identifies a specific project. At
present, thisisignored. Any number may be used.
Comment Any remaining text up to the end of the line

6.1 Additional itemsembedded in comments

CONFIGURE adlows a number of optional additional items of information about target
objects to be included in the input file. Thisis another feature introduced for FLAMES, and is
probably not applicable to 2dF/6dF, although they are still supported. These are included in
the comment field, and take the form of strings

(Name)=value

or

(Name=vaue)

These can be delimited by commas, blanks, or semi-colons, and should be at the start of the
comment string. The following names are accepted within the parentheses.

BAND Band designation for the magnitude specified (B,V,R)

B-V Object colour index, B-V

V-R Object colour index V-R

PM-RA Annual right ascension proper motion for the equinox J2000 in
the FK5 system in arcsec per year.

PM-DEC Annual declination proper motion for the equinox J2000 in the
FK5 system in arcsec per year.

SNR Signal to noise ratio requested by the observer.

CATEGORY Object morphology: Stellar or Extended

DIAMETER Source extension diameter for extended objects, in arcmin.

6.2 Possible object types:

The following letters are accepted in the ‘ Type’ field for an object:

P Program object. For 2dF and 6dF, thisindicates atarget that
should be assigned to a single fibre connected to one of the
spectrographs.

P1 Program object that may only be assigned to spectrograph 1.
This appliesto 2dF only.

P2 Program object that may only be assigned to spectrograph 2.

This applies to 2dF only.
S Sky. This indicates a position that can be used for sky. Such a target may be assigned
to any spectrograph fibre.
F Fiducial (reference star). Thisindicates atarget that should be
assigned to a guide fibre.
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For FLAMES, a large number of other object types are supported. For detals, see the
FLAMES manual.

6.3 Example Text Input File

* This is a coment |ine

LABEL target field nunber 1 xyz cluster
UTDATE 1994 05 12

CENTRE 12 43 23.30 +10 34 10.0

* end of required header info

*

F1 12 40 20.55 +10 30 11.4 F 6 12.0
F2 12 38 10.31 +09 59 58.9 f 6 13.5

*

[EY

brightest star

[EY

fiducial star

NGC1002 12 41 30.55 +10 31 56.9 P9 15.0 1 small fuzzy gal axy
i 3082 12 40 18.40 +10 32 21.5 P9 * 1 candidate satellite

*

sky-1 12 40 10.00 +10 32 21.5 S3 * 1 bl ank sky (checked)



Fibre Positioner Page 22 of 62
AA O 2dF/6dF CONFIGURE User Manual Issue 1.1, 12 Mar 2003

7 The CONFIGURE program

This section isamore formal description of the CONFIGURE program.

The CONFIGURE program is used to perform the following main functions:

» Performing the allocation of objectsto fibresin a 2dF/6dF field.

» Checking the validity of fibre allocations over arange of dates and hour angles.

» Generating a file describing the field configuration and allocations that can be used as
input to the 2dF or 6dF observing systems.

7.1 Runningthe FLAMES configuration program

The program is started with the command configure typed at the UNIX shell prompt. This
will bring up three windows. The control window contains a menu bar, status display, and
message region. The largest window — the ‘mimic’ window — will be used to display a
graphical representation of the configuration being generated. A ‘basic sequence’ window
provides a guide through a basic sequence of operations needed to generate a configuration
for 2dF/6dF.

7.2 Openingfiles
The configuration program can read data from three types of file:

» Text files containing a description of the field in the standard format described earlier in
this document. These are lists of targets and contain no fibre alocations. The default
extension for thesefilesis .fld.

e Configuration files in the standard FLAMES format used at ESO. These are PAF files
used as input by the FLAMES observation software, and will invariably be created by the
configuration program itself. It is possible to use PAF files as intermediate files for
2dF/6dF configurations, although there is nothing to be gained by so doing. There may be
cases where the fact that PAF files are human-readable text files may be useful, but you
would need to know the detailed format to make use of it. In general, you will not use
PAF files for 2dF/6dF configurations.

» Configuration files in the binary SDS format used by AAO. This format is the default
output format used by CONFIGURE for 2dF/6dF configurations. They can also beread in
by CONFIGURE. Thisformat is required by the 2dF and 6dF instrument control software.

Note that an astronomer will always start by generating a text file describing the targetsin a
field. From this, a number of different configuration files can be generated in SDS (or,
unusually, PAF) format. If the astronomer or the operations staff want to check or modify a
configuration then these files can be read back into the configuration program and new
versions can be created.
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To open a configuration text file select Open... from the File menu and select your file using
the file selection dialogue that appears. By default, a file extension of .fld is expected for
configuration text files. Alternatively, select the Open File option from the basic sequence
window. If an input file contains a large number of targets, you may want to set a magnitude
filter first to restrict the targets considered by the program to those within the magnitude
range specified. To do so, select the Magnitude Filter option from the basic sequence
window.

To open an SDS configuration file select Open SDS... from the File menu and select your
file using the file selection dialogue that appears. By default, a file extension of .sds is
expected for SDS configuration text files.

To open a PAF configuration file select Open PAF... from the File menu and select your file
using the file selection dialogue that appears.

On opening your file the status display will show a summary of information about the field,
and the objects in the field will be drawn in the mimic window. In the case of atext file no
fibre alocations will be present, so the fibres will al appear in the mimic display at their park
positions. A PAF or SDS file may already include fibre allocations and these will be shown
on the display. To remove any existing allocations in order to start from scratch use Remove
Allocations from the Commands menu.

7.3 Converting Files

The configuration program can be used as a way of converting configuration files between
text and SDS or PAF formats, in either direction.

To convert a text configuration file to an SDS configuration file, use Open... from the File
menu to open the file, then use Save or Save As... to save the file in SDS format. This
sequence can be performed non-interactively using the —d switch on the command line when
configure isinvoked. (See the section on running in batch mode.)

To convert an SDS configuration file to a text file, use Open SDS... from the File menu to
open the file, then use List... to output the file in text format. The output file produced by
List... is a valid configuration text file containing the unallocated objects from the
configuration file. (List... aways uses an equinox value of J2000 when writing its output
files.)) It may aso include a listing of the fibre alocations in the form of comments in the
listing.

7.4 Setting the Waveength

Before allocating fibres it is important to set the desired observing wavelength. It is possible
for an alocation that is valid a one wavelength to be invalid at another wavelength.
Therefore, use the Set Wavelength... option in the Commands menu to set the desired
central wavelength of observation. For 2dF, if the two spectrographs will be obserbing at
different wavelengths, it will be necessary to choose a single observing wavelength that will
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be a reasonable compromise between the two actual observing wavelengths. A future version
of configure will allow separate observing wavelengths to be set for each spectrograph.

7.5 SettingtheField Plate

For some instruments, you may want to configure for a particular plate, for example when
running online during a telescope run, or checking a field for the telescope. This is necessary
because both plates always have different fibre and astrometry information. For FLAMES, it
has been decided that any configuration must be valid for either plate. The plate data used by
FPOSS is therefore a combination of the data for the two actual plates (so a fibre broken on
either plate will show up as a broken fibre, for example).

To set the desired plate use the Set Field Plate... option in the Options menu. The default is
to use plate O, but this can be changed using the p command line option. FLAMES can only
accept plate 0. For 6dF, the field plates are known as plate 1 and plate 2, rather than 2dF's
plate 0 and plate 1.

7.6 Overview of the Allocation Procedure

Automatically allocate fibres by selecting Allocate... from the Commands menu. This will
bring up a dialogue box with a number of parameters controlling the allocation process. The
default parameters will normally be suitable. During the alocation process, which will
typically take under a minute to complete, a progress window will report on the progress of
the allocation, and the mimic window and status display will be updated as new fibres are
allocated.

The default is to leave no fibres unallocated if possible, but you can specify a number of
fibres to be left unallocated for sky targets. Once the object alocation is complete you can
assign these to sky positions. These can either be generated on a standard grid (using Allocate
Sky Grid... from the Commands menu) or they can be supplied in the input file.
Alternatively, you can add sky positions manually.

Once the allocation is complete, it will be checked for validity at the current position. As an
extra step, you should select Check Over HA Range from the commands menu to check the
validity of the field over arange of hour angles (the default is to check for plus or minus four
hours from the meridian on the date set by the UTDATE field in theinput file).

Saving the configuration as an SDS file will now give you an input file for the 2dF or 6dF
positioner. Y ou should ensure that all the available guide fibres were sel ected.

7.7 TheAllocation Procedurein detail

The above recipe will suffice for the majority of fields. The hardware constrains the fibres to
an angular limit from the radia direction which is instrument-dependent, but fibres are
allowed to cross multiple times and in most cases all of them can be allocated to targets.
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There are two basic alocation algorithms available, and these can be selected using the
allocation dialogue panel — this can be seen in Figure 21. These are the ‘Oxford’ agorithm,
also known as the ‘iterative’ or ‘cones algorithm, and the ‘Taylor’ agorithm, which has a
number of variations such as ‘ straightest target’, ‘hardest target’, ‘ most crowded target’. There
are then two additional options that you might want to consider, the tentative deallocation
option and the fibre uncrossing option. You can also specify how many sky targets you want
allocated to the various fibre types (in the case of 2dF/6dF this means that you choose how
many sky targets you want allocated to the two spectrographs).

In general, the main determinant of which agorithm to use is the number of targets you are
trying to deal with. If you have more or less the same number of targets as you have fibres,
then you will generally get the best results using the ‘Oxford’ iterative algorithm, bypassing
tentative deallocation, and with afinal uncrossing pass. If you have alarge number of targets,
you may find this too slow an algorithm. In this case, you are usualy best off with the
‘hardest target’ variation of the ‘Taylor’ agorithm, followed by both a tentative deall ocation
pass and an uncrossing pass.

Experienced users will have their own preferred recipes, often using some of the additional
options made available in ‘expert’ mode. (Even experienced users, however, will find that the
current version of CONFIGURE has made changes to the * Oxford’ algorithm, particularly in
the swap phase, that may mean they should reconsider some of their recipes. The swap phase
now takes longer, but generally resultsin rather better configurations with may need less post-
alocation optimisation.) Those prepared to spend time in the search of the ultimate
configuration may use the individua allocation and deallocation facilities offered by the user
interface, allocating and deallocating fibres by hand.

7.71 The Oxford’ algorithm

The agorithm currently used for 2dF (developed by Gavin Daton at the University of
Oxford) is highly optimised and has proven to give the best results for ‘typical’ fields,
particularly when the number of targets is roughly the same as the number of fibres. This
algorithm is invoked by selecting the iterative target allocation option from the allocation
dialogue. After an initial allocation it searches down a tree of multiple fibre swaps, looking
for swaps that give increased allocations. The algorithm is not unlike a chess program. The
tree search terminates at a depth of ten swaps where it has been found, empiricaly, that the
expenditure of CPU time required to deepen the search is not rewarded by increased
allocations.

It is worth describing the operation of the algorithm in more detalil. It is sometimes described
as the ‘cones’ agorithm, because the concept of a cone with a target at its apex is an
important part of the algorithm. Imagine a target somewhere in the field. Simply because of
the limitations on the amount a fibre is allowed to bend as it leaves its pivot point, there are
only a limited number of fibres that are physically able to reach this target. Imagine drawing
the two extreme fibres out of all these, connected to the target in question. Combined with the
sector of the pivot circle between the pivot positions of these two cones, these two extreme
fibres delineate a ‘ cone’ with the target at its apex. Now, the important point is that this cone
will usualy include other targets, and the fibres that originate within the cone are able to
reach other targets outside the cone. However, the only fibres that can reach the targets in the
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cone are those originating within the cone. Imagine that there are just as many fibres
originating in the cone as there are targets in it. (Thiswill be the case where there are roughly
as many fibres astargets, all evenly distributed.) This means that if thereis no excess of fibres
over targets for this cone, then it is going to be important that none of the fibres are allocated
to targets outside the cone. If there is an excess of targets over fibres for the cone, it becomes
particularly important to allocate al the cone fibres to targets within the cone.

The algorithm therefore considers all the possible cones formed by targets within the field,
and sorts them into an order of importance, regarding the most important as those with the
biggest excess of targets over fibres. The targets defining these cones are the ones it attempts
to alocate first. The initial alocation passis quite simple. The algorithm takes all the highest
priority targets (those of priority 9) and sorts them into order of importance based on the
target/fibre ratio for the cones they define. It then attempts to allocate targets to fibres in order
of importance. It then repeats the process, this time including targets of the second priority
rank (ie it now handles priorities 8 and 9). And so on, each time including lower priority
targets, until it has done a pass with al targets.

This alocation process is quite fast, but generally leads to a somewhat unsatisfactory
configuration, with a number of allocated fibres blocking the allocation of other currently
unallocated targets. The algorithm then enters a ‘swap’ phase. In this phase, it attempts to
improve the alocation by tentatively deallocating fibres. It takes an unallocated target (again,
working in the ‘cone’ order of importance). Clearly, with the configuration as it stands, there
is no fibre that can be alocated to this target. So it looks at each fibre that can be allocated to
the target — at least on physical bend angle grounds — but is currently allocated. If there is one
that can be deallocated from its current target and immediately allocated to the unallocated
target, then it does so. It now has a different unallocated target. It may be that this slightly
modified configuration will alow a fibre that was parked to be alocated immediately. If so,
this is an immediate gain. If not, the algorithm just starts again with the new unallocated
target, looking to see if there are currently allocated targets that can be swapped with it that
might lead to a gain of a parked fibre. There is a safeguard that prevents the code from
making ‘false’ gains — gains obtained by allocating more than one low priority target at the
expense of a high priority target. This ‘swap’ phase is potentially quite time consuming,
particularly if there are a large number of unallocated targets — so time consuming that you
may want to avoid the iterative algorithm if you have a large number of targets. You can
cancel it at any time, should it be taking too long, so there is no reason not to try it to see
whether you regard the time needed as unacceptable.

7.7.2 The‘Taylor’ algorithm

For fields with a large number of target objects — far more than the number of fibres — the
swapping phase of the iterative target algorithm can take too long for this algorithm to be used
successfully. For such fields, better results are obtained by an algorithm due to Keith Taylor.
This operates in a number of different modes, and is invoked by selecting ‘by most
crowded’, ‘by hardest target’ or ‘by straightest target’ in the allocation dialogue.

This agorithm is relatively easy to understand. It assumes that the hardest pivots to allocate
will be those that can be allocated (on grounds of physical constraints, such as fibre bend
angle, fibre length, etc. and target/fibre compatibility) to the fewest targets. It therefore
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allocates the pivots to targets in order of decreasing difficulty, starting with the hardest pivot
to alocate. Having decided which pivot to alocate, it then has to pick atarget for it. It will
allocate to the highest priority target available for that pivot. If more than one target of the
same priority can be allocated, then the decision depends on just how the agorithm was
invoked.

If ‘by hardest target’ was selected, it picks the target that can be assigned to the fewest
fibres. These targets are going to be hard to allocate, so it tries to allocate them as soon as
possible.

If you selected ‘by most crowded’, it picks the possible target with the least average distance
to other targets. Thisis suitable for fields that have areas that are particularly crowded, and in
particular, for cases where the user is trying to get a number of configurations that will,
together, cover a large target list. (The ‘hardest target’ option will often alocate a greater
number of targets for a single configuration, but will do so by ignoring crowded targets,
leaving these to be covered by the final configurations in a set, which is unsatisfactory.)

If you selected ‘by straightest target’, it picks the target that will bend the fibre the least.
This option produces allocations with the minimal number of crossed fibres, which can be a
consideration if exposure times are small and it is important to be able to reconfigure the field
as quickly as possible.

7.7.3 Tentative deallocation

If you selected tentative deallocation in the allocation dialogue, the program performs a pass
where it tentatively deallocates each allocated fibre in turn and then sees if this allows more
than one other allocation to be made. If so, there has been a gain from this deallocation. The
option takes a little time, but can often squeeze a few extra allocations out of a field. This
option is normally only used when the main allocation is done using the Taylor algorithm,
since the swap phase of the Oxford algorithm is really a much more comprehensive case of
the tentative deall ocation pass.

7.74 Fibreuncrossing

The optional final ‘uncrossing’ pass looks at all pairs of alocated fibres which cross to see if
they can be reversed. This is important, as reducing the number of fibre crossings in the fina
configuration produces a significant reduction in the field setup time by reducing the number
of fibres that must be parked in transit. Note that this reduction is obtained without
constraining the allocation itself.

7.75 Sky allocations

The allocation dialogue alows you to specify how many sky targets are to be allocated to
each fibre type. (Thisis not useful in 6dF, where sky targets can only be allocated to the 6dF
spectrograph fibres, but it can be useful for 2dF, ensuring that each spectrograph gets a
roughly equal number of sky fibres.) This is implemented rather simply. At the end of the
allocation, the program looks to see if there were explicit sky targets specified in the target list
(either in the original input file, or through the generation of a sky grid or the explicit
nomination of a given position as a sky position).
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If there are sky targets available, the program attempts to allocate the specified number of
fibres of each type to the available sky targets. If necessary, it will deallocate low priority
targetsin order to free up enough fibres for the specified number of sky targets.

If no sky targets are available, the program assumes that you plan to generate a sky grid or
specify sky targets explicitly, and it ssimply deallocates fibres allocated to sufficient low
priority targets to ensure that the specified number of fibres are unallocated.

7.8 Target Priorities

The targets are allocated in order of priority, with a numerical value of 9 being the highest
priority and 1 being the lowest. To ensure all guide fibres are allocated it is best to give guide
targets the very highest priority values.

7.9 Theallocation window

When Allocate... is selected from the Commands menu, the alocation window appears. This
allows you to control the details of the alocation procedure. The window is shown in Figure
21.

The parameters here control the various steps of the alocation. The default is to allocate the
maximum number of targets and optionally leave a number of fibres for subsequent sky
allocation.

* Target selection alows the selection of the allocation algorithm as described in the
previous section on the allocation algorithm in detail.

* Fibre uncrossing controls aspects of the fibre uncrossing scheme. The default is to
uncross at the end of the allocation, which will suffice for most fields. If there are many
priority levels of object, one can sometimes gain in alocations by selecting uncrossing
after each priority pass, though this is more time consuming. It is also possible to uncross
existing configurations either here or by selecting Uncross Fibres in the Commands
menu and then proceed to allocate extra objects without removing the existing allocations.

7.10 Sky Fibres

It isimportant to have sufficient sky fibres allocated.

You can supply sky positions in the input catalog — for example, positions which have been
carefully checked on images to ensure absence of bright objects. To assign to these, make
sure that you have suitable values set in the boxes in the allocation dialogue that allow you to
specify the number of fibres of each type that are to be allocated to sky targets.

If you do not have sky positions in your input catalog, you should still use the same boxesin
the allocation dialogue that allow you to specify the number of fibres of each type that are to
be allocated to sky targets. If there are no sky targets at al in the target list, the specified
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number of fibres of each type will be left unallocated in the normal allocation process. Y ou
may then create a grid of sky positions and allocate these positions automatically by selecting
Allocate Sky Grid... from the Commands menu.

Finally, arbitrary sky positions can be assigned interactively (see below).

It may be desirable to check the positioning of sky fibres that have been automatically
allocated or added by hand, to ensure that these are not contaminated by stray objects,
particularly brighter stars. This can be done by selecting List... from the Commands menu,
and checking the Allocated Sky as DSS input button. Thiswill list all alocated sky positions
as J2000 coordinates to a file (the default file name is the same as that of the input file, but
with the extension .dss) which is in the correct format to be read by the commonly available
StScl getimage program. The sky positions are named Snnn in the .dss file, where nnn is the
fibre number. The content of the sky fibres can then be conveniently checked using a FITS
aware visua browser (eg the visual schnauzer in xv). Alternatively, you can generate alist in
SKYCAT format and look at the sky positions using SKY CAT.

7.11 Manual Allocation of Fibres

It is also possible to manually allocate individual fibres to objects. If you are using a priority
scheme for alocating targets then you can highlight all allocated or unallocated targets within
agiven range of priorities using the Highlight Targets... option in the View menu.

Manual alocation is performed by interacting with the mimic display as follows:

» Select afibre by clicking on its button — it will be highlighted in blue.

» Select an object by clicking on it —it will also be highlighted in orange.

» Select Allocate Fibr e from the Commands menu.

The validity of the resulting configuration will be checked, and a progress dialogue will be
displayed as this happens. If the resulting configuration is valid the allocation will be made
and the display updated. If it isnot valid, an error dialogue will appear.

There is a short cut in the manual allocation procedure that avoids the use of the menu as
follows:

» Select afibre by clicking on its button.

* Movethe cursor over the desired object and click the middle mouse button.

It is possible to manually allocate fibres and then select ‘uncross first then allocate extras
in the alocation dialogue window to automatically assign the rest of the fibres while

preserving the manual allocation. (Thisis an expert mode option)

It is aso possible to deallocate fibres manually as follows:
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» Select afibre by clicking on its button. Y ou need to position the cursor carefully to ensure
you select the fibre rather than the object. Make sure the fibre button is highlighted in red.
This operation is easier if the display is zoomed.

* Sdect Deallocate Fibre from the Commands menu.

Sky positions, either included in the input configuration file or generated as a sky grid, are
allocated in the same way as objects. However, there is an additional facility that allows you
to create an arbitrary sky position anywhere in the field. To do this, select a fibre in the
normal way with the left mouse button. To assign it to a sky position use CTRL + middie
mouse button. This creates a sky target in the configuration under the cursor and attempts to
assign a fibre to it and is most useful for assigning miscellaneous unallocated fibres to
nominal sky positions.

7.12 The Mimic Display

The display can be zoomed to magnifications of 2,4, or 8 times its norma scale using the
Zoom menu. The zoomed display can be scrolled using the scroll bars.

It is also possible to zoom the display by a factor of two about any selected point by clicking
the right mouse button with the cursor positioned at the desired centre.

In the display, reference stars are shown as large red circles, target objects as small black
circles and sky targets as blue squares. VLT guide stars are shown as large cyan circles. Fibre
buttons are shown in different colours to distinguish between different fibre types. Disabled or
non-existent fibres are shown in red. Highlighted objects and fibre buttons are shown in blue.
Information about individual objects or fibres in the display can be examined by double
clicking on the objects or fibre buttons.

The display can be printed by selecting the Print... command from the File menu. A
postscript version of the mimic window will be generated which can either be sent directly to
aprinter or saved as afile, according to selections in the resulting dialogue box.

7.13 Saving a Configuration

After completing the allocation process and checking its validity, the resulting configuration
can be saved as an SDS file by using Save or Save as SDS... from the File menu. The
resulting SDSfileisin aform suitable for use by the 2dF and 6dF observing systems.

It is also possible to save the configuration in ESO’s PAF format, using the Save as PAF...
option in the File menu.

A text file listing the fibre alocations and/or the unallocated objects can be obtained by
selecting the List... option from the File menu.
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7.14 Batch Mode

It is recommended that the configure program be run interactively. However, thereis a limited
feature for using it in batch mode. To make configure read in the input configuration file
filename.fld and allocate it automatically, use the command:

configure —a —f filenane.fld
(Note: the command to start configure may be different on your system.) This will produce
two new files, filename.sds and filename.. The first can be fed back into the program in
interactive mode to show how the fibres have been allocated. The second is a text file that

contains details of the pivot alocation and can be processed by some other program to
anayse the way the field has been configured).

7.15 Command Line Switches

The configuration program supports a number of command line options.

-a Invokes batch mode.
-f filename Specifiestheinitial input file.
-l instrument Specifies the instrument to be used. Thisisonly useful if the

program has been configured with support for a number of
different instruments, in which case it eliminates the initial
dialogue where configure asks you which instrument to use. For
2dF one would use - 2dF.

-k Disables fibres which go to a particular spectrograph. (This
option is under review at the moment.)

-p N Setstheinitial plate.

There are also a number of options that can be used to perform specific actions when invoked
with the —f option:

-i Specifies an ASCII file to read with a set of fibre number, fibre
name pairs. Thisfilewill be used to perform a specific set of
allocations with no checks whatsoever. It will then write an
output file and exit.

-d Instructs configure to read in the .fld file, write out a .sdsfile
with no allocations and then exit. Thisis useful if there are
targetsin thefile that you wish to inspect with 2dF s focal plane
imager.

-S Instructs configure to interpret the argument of the —f flag asa
sdsfile. Thisfileisread in and an auto-reallocation passis
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performed, followed by an additional allocation pass and an
allocation of remaining fibresto the grid of sky positions. This
option was introduced to 2dF for the Galaxy Redshift Survey.
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8 Obtaining and installing the program

CONFIGURE can be obtained, from the AAO, viathe web. The 2dF home page can be found
under the address:

http://www.aa0.gov.au/2df

and links on this page will lead you to CONFIGURE. CONFIGURE is distributed in the form
of a binary file suitable for Solaris 2.6 (SunOS 5.6), Linux (built under Red Hat 7.1) or
MacOS X, asagzip'ed tar file. Create an empty directory and gunzip it, then un-tar it into the
same directory. The directory will now contain the program itself, configure, together with a
number of .tcl files it uses and a couple of additiona files that provide details of the
instrument configurations and bitmaps used by the program. It will also contain two sub-
directories that contain the Tcl/Tk files needed to run CONFIGURE.

(Users should make sure they are running the latest version of the program. In particular,
they should make sure they are using the latest version of the instrument status file they need:
fpinsSatus.sd for FLAMES tdFconstants.sds for 2dF, sixdFconstants.sdf for 6dF, since this
has the most up to date configuration for the fibres — including details of any broken fibres. In
addiiton, 2dF requires a number of astrometric files, tdFlineaOr.sds, tdFlinearl.sds,
tdFdistortion0.sds and tdFdistortionl.sds. These exist in a number of different versions,
suitable for different declination ranges. You should check that you have the latest versions of
these, and that you are using the files appropriate to your declination range. These constants
files are not included in the software distribution. These files must be separately downloaded
from the AAO web site.)

The program is a straightforward tcl/tk program, which is why it is relatively easy to port to
various different platforms. The main requirement is that tcl/tk should be available for the
target platform.
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9 TheMenusin detail

This section describes the menu contents for the all the menus available in the main control
panel — the File, View, Options, Commands, and Zoom menus. All the features of the
program are available through these menus. Note that there are additional menu items
available if the program is run in ‘expert’ mode. These are shown in the next section. Note
also that the menu items vary slightly depending on which instrument is being configured.
The menus shown here are those seen when 2dF or 6dF are in use.

9.1 TheFilemenu

Figure 2 shows the File menu. Note that this is shown when the configuration program is
being used to configure 2dF or 6dF. For FLAMES, PAF file format is the default rather than
SDS, and thisisreflected in the menu options.

006 Fie
Open... ("0}
Open SD5...
Merge...
save (*~3)
save As Sds file...
save Alloc to UnAlloc...
List...
Print...
Exit ~E

5

I

Figure 2 Thefilemenu

Open Puts up afile selection dialogue to read in anew list of targets
from atext input file (usualy a .fld file). If afileis aready open
and has not yet been saved, you will be asked if you want to
save it before opening the new file.

Open SDS Puts up afile selection dialogue to open an SDSformat file
(usually afile saved as the result of a previous run of
CONFIGURE). Thiswill put the program back to the state it
was in when that file was saved, at least so far asfibre
alocations are concerned. If afileis aready open and has not
yet been saved, you will be asked if you want to save it before
opening the new file.
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Saveas SDSFile Puts up afile selection dialogue allowing you to save the details
of the current configuration in SDS format.

List... Puts up adialogue box alowing you to specify what details
should be included in the list file to be created, and then puts up
afile selection dialogue box to allow you to specify the name of
the list file. This can be used to generate catal ogues that can be

read by Skycat.
Print... Creates a printed version of the mimic display window.
Exit Exitsthe program.

9.2 TheView menu

Figure 3 shows the View menu.

r "|

BO6 view
Select targets...
Use grey shades for display

Figure 3 The view menu

Select Targets Puts up adialogue that alows you to highlight target objects of
different types. For example, you can choose to highlight
targetsin agiven priority range, or targets that are classified as
sky targets. Highlighting is quite subtle and if there are alarge
number of targets even ahighlit target may not show up
sufficiently. So this dialogue also alows you to redraw the
mimic display with al targets magnified. It also has an option
that indicates al highlit targets with large blue arrows — the
result is unsubtle, but quite obvious.

Use grey shades for display Switches from using colours to differentiate between fibre types
to using different shades of grey. Some usersfind it easier to
distinguish shades of grey rather than colours. This option is
only activeif grey shades are not aready being used.

Use colours for display Switches from using different shades of grey to differentiate
between fibre types and using colours. Most usersfind it easier
to distinguish colours rather than shades of grey. Thisoptionis
only activeif colours are not already being used.
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9.3 The Options Menu

Figure 4 shows the Options menu.

B O 6 options
set Field Flate...
set magnitude filter...
Change Field Label
Change Observation Date
select Fibre Combination
I Expert

r

Figure 4 Options menu
The options menu provides control over anumber of possible options for the program.

Set magnitude filter... Puts up adialogue box that allows you to change the magnitude
range used to filter theinput target list.

Change Field Label Allows the label for the field to be changed.

Change Observation Date  Allows the date of the observation to be changed. This may
invalidate any existing configuration, and so if fibres have
already been allocated the configuration should be checked
using the Check Allocation option in the Commands menu.

Select Fibre Combination  Puts up a menu showing all the fibre combinations supported by
the instrument, allowing one such combination to be specified
for use when fibres are allocated. This allows the same input
configuration file to be used to generate a number of different
configurations depending on which instruments are in use.

Expert Allows the program to be set into ‘expert’ mode. This makes
available a number of additional features, described in detail in
the next section. The check box next to this option isfilled if
‘expert’” mode is already selected. (And there are more options
shown in expert mode.)

9.4 TheCommandsMenu

Figure 5 shows the Commands menu.
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B O O commands

Allocate... (F4)
Auto-Reallocate...

Check Allocation

Check over HA range...(F2)
Generate Sky Grd...
Uncross Fibres...

set Hour Angle...

set Wavelength...

Remowve Allocations...

set field center...
Deallocate Broken Fibres
Deallocate Sky Hbres

i

Figure 5 The commands menu

The Commands menu allows you to invoke most of the operations that CONFIGURE can
perform.

Allocate Performs a complete fibre allocation. It puts up the allocation
dialogue that allows you to modify the parameters used by the
allocation agorithm, and then starts the allocation process.

Auto-reallocate Invokes the allocation agorithm in a mode where it modifies
the current allocation to allow for broken fibres. Thisis useful
when an existing allocation has been read in from an SDSfile
but the instrument setup has changed since the allocation was
made.

Check Allocation Performs avalidity check on the current allocation. Thisis
useful when an existing allocation may have becomeinvalid —
for example, because the observation time has been modified.

Check Over HA range Puts up a dialogue allowing you to check the current allocation
over arange of dates and hour angles.

Allocate Sky Grid Automatically allocates a grid of sky targets. Thisisan
alternative to providing a specific set of sky targetsin the input
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Uncross Fibres

Set Hour Angle

Set Wavelength

Remove Allocations

Allocatefibre

Dedllocate fibre

Show fibreinfo

Set field center

Deallocate Broken Fibres

target file, but of course the program has no way of knowing
what parts of the target field are really clear and suitable for use
as sky.

Invokes the allocation agorithm in a mode that merely attempts
to exchange fibre/target alocationsin such away asto
mimimise the number of fibre crossings.

Puts up a dialogue box alowing you to specify the hour angle
for the observation. After a change such as this you should
check the validity of the allocation (if there is one) using Check
Allocation.

Puts up a dialogue box alowing you to specify the central
wavelength for the observation in angstroms. Thiswill change
the plate positions of the various targets very slightly, and
should check the validity of the alocation (if there is one) using
Check Allocation.

Removes all the current fibre/target allocations, if any. A
dialogue box is put up asking you to confirm that you want this
doing.

Thisisonly active if afibre has been selected (by clickingonin
the mimic display) and atarget has been selected (also by
clicking on in the mimic display). It causes that fibre/target
allocation to be made and verified. This can be useful asa
check on why the algorithm did not make what appears to be an
obvious allocation — select the fibre and target in question and
use this option to allocate them explicitly. You will often get an
error message explaining why the allocation cannot be made.

Only active if afibre has been selected (by clicking oniit in the
mimic display). If the selected fibre has been alocated to a
target, this causesit to be deallocated and returned to its park
position.

Only active if afibre has been selected (by clicking on it in the
mimic display). Puts up awindow giving details about the fibre.

Moves the field center so that the field is now centered at the
place last clicked on the mimic display. So theideaisthat you
click on the mimic display at the required field center, then
select this menu option. Y ou will see adialogue box asking you
to confirm this change. This change will invalidate any current
configuration.

Removes any allocations that involve broken fibres. Y ou can
only get such an alocation by reading in a configuration (from
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an SDS or PAF file) that was made with a different instrumental
setup file.

Deallocate Sky Fibres Removes any alocations that involve sky targets. (The name of
the menu item is alittle misleading — it is the target that is sky,
rather than the fibre, although it istrue, for example, that all
ARGUS fibres are sky fibres.)

9.5 TheZoom menu

Figure 6 shows the Zoom menu.
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Figure 6 The zoom menu

This menu permits you to select a display according to a range of scale factors. You can
reduce the image size, as well as expand it from the usual size. The zoom menu just presents a
set of 6 zoom values that are generally useful. More extreme values can be obtained by right-
clicking in the mimic display. (Note that there is no dialogue that alows a completely
arbitrary zoom factor to be specified.)

10 Expert Mode

CONFIGURE has an ‘expert’ mode. It provides a number of additiona menu items,
additional options in dialogues (particularly the allocation dialogue), and removes a number
of restrictions.

10.1 Invoking expert mode

Expert mode is invoked through an ‘Expert mode’ item in the ‘Options menu. This is a
toggle that takes the program in and out of expert mode.
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10.2 Menusin expert mode

This section shows al the control panel menus as they appear when expert mode is selected.
In expert mode, new options appear at the bottom of al the menus (except for zoom, which is
unchanged in expert mode). This section only provides explanations for those items that are
unique to expert mode.

10.2.1 The File menu in expert mode

Figure 7 shows the File menu in expert mode. Note that this is shown when the configuration
program is being used to configure FLAMES. For other instruments, SDS file format is the
default rather than PAF, and thisis reflected in the menu options.

85060 fe
Open... (*0)

Open 5D5...
Merge...

save (“3)

Save As Sds file...
save Alloc to UnAlloc...
List...

Print...

Open PAF...

save As PAF file...
Exit ~E

r -

i

Figure 7 The File menu in expert mode

The additional options that are available in expert mode are:

Open PAF Puts up afile selection dialogue to open an PAF format file
(usually afile saved as the result of a previous run of FPOSS).
Thiswill put the program back to the state it was in when that
filewas saved. If afileisaready open and has not yet been
saved, you will be asked if you want to save it before opening
the new file.

Merge... Puts up adialogue that allows you to specify the name of an
existing SDS format file (usually one saved during a previous
run of the configuration program). The lists of unallocated
targetsin the current configuration (both guide and non-guide
targets) are replaced by those in the specified file.
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Save (NS) Puts up afile selection dialogue that allows you to save the
current configuration afile in the default format for the
instrument. So if the program is producing configurations for
FLAMES the save will be to a PAF format file. If 2dF or 6dF is
not being used the save will beto afilein SDS format.

Save as PAFfile Puts up afile selection dialogue that allows you to save the
current configuration as a PAF format file. Thisis the default
file format used when configuring the ESO FLAMES
instrument.

Save Alloc to UnAlloc This command is used to prepare a currently configured field
for reconfiguration on the other plate. It copiesthe list of
allocated targetsinto anew file as alist of unallocated targets.
Configuring using this new file will ensure that only those
targets originally configured will participate in the new
configuration for the new plate.

10.2.2 TheView menu in expert mode

Figure 8 shows the View menu in expert mode.
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Figure 8 The View menu in expert mode

The additional options that are available in the view menu in expert mode are:

Show empty fibre positions In the mimic display, only fibresthat are directly participating
in the current configuration are normally shown. In additon,
there are a number of fibre positions that are given numbers, but
do not actually have fibres. These are also usually not shown. If
‘show empty fibre positions' is selected, all fibres (even those
that are only placeholders for non-existent fibres) are shownin
the display. Thisoption isonly active if empty fibre positions
are not being shown.

Hide empty fibre positions  Reverts to the default mode where only only fibres that are
directly participating in the current configuration are shown in
the mimic display. Thisoption isonly active if empty fibre
positions are being shown.
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10.2.3 The Options menu in expert mode

Figure 9 shows the Options menu in expert mode.
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Figure 9 The Options menu in expert mode

The additional optionsthat are available in the options menu in expert mode are:

Buffer Display Update

Full Display Update

Select Fibre Type

Puts the program into a mode where changes to the mimic
display are buffered and applied only when the buffer isfull.
This makes the program run faster, but at the expense of a
rather jerky display. In practice, the buffering code has changed
recently and there is now little difference between the two
buffering modes.

Puts the program into a mode where changes to the mimic
display are applied as soon as the underlying configuration
changes. This makes the program display smoothly, but at the
expense of some additional execution time, particularly on X-
terminals. In practice, the buffering code has changed recently
and there is now little difference between the two buffering
modes

Puts up a dialogue that alows the various fibre typesto be
selected independently. This alows non-standard fibre
combinations to be selected, and so should normally be
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Refraction parameters

Telescope Parameters

avoided. Thisisthe only way to create a configuration that uses

test fibres.

Puts up adialogue that allows the refraction parameters built
into the astrometric model to be modified.

Puts up adialogue that allows the telescope parameters built
into the astrometric model to be modified.

10.2.4 The Commands menu in expert mode

Figure 10 shows the Commands menu in expert mode.
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Deallocate Sky Fibres
Import Allocations...
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Figure 10 The Commands menu in expert mode

The additional options that are available in the commands menu in expert mode are:

Import alocations

Tcl command

Puts up adialogue allowing you to select afile that contains a
list of fibre/target allocations and apply those.

Puts up adialogue that allows direct Tcl commandsto be
entered. Thisisavery powerful facility, but needs intimate
knowledge of the program’ sinternal structure and Tcl code to
be useful. Anyone without such knowledge should avoid this
command. Anyone with such knowledge will already know to
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avoid using this command. (It is mostly for the convenience of
program devel opers, allowing features to be exercised for which
no GUI control isavailable yet.)
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10.3 The Allocation Dialogue in Expert mode

When the program is running in expert mode, a number of additional options are available in
the allocation dialogue. The expert mode alocation dialogue is shown below in Figure 11.
Note that the allocation dialogue now has so many options that on some screens it needs to be
scrolled. It is shown here as a single screen without scrolling.

Set Allocation Parameters and Hit OK to Allocate

Fibre clearance (400 to 40000 mictons) i4ED
Button clearance (400 to 40000 microns) {450
Max non-radial pivot angle (0.00 to 14.32 degrees) i1 2.000000
- by most crowded target
- by Turthest target
-~ by hardest target
~ by straightest target
Target selection 4 iterative target allocation
~ auto-reallocate
~~ Only allocate sky
~,~ import ascil allocation table
~ import with no checks
4 never
Tentative deallocation - If Tibres are unallocated
~» even if all fibres are allocated
-~ hever
- after each priority pass
Fibre Uncrossing 4 when allocation completed
- UNCross only
~- uUncross first then allocate extras
Fbre to recover |1
Priority for Bonus Targets 4
Lowest Fibre for sky {1
Highest. Fibre for sky 404

Humhber of Spect 1 fibres to assign to sky |21
|21

Humber of Spect Z fibres to assign to sky

Figure 11 The Allocate dialogue in expert mode
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This shows the clearance parameters used by the program. Note that in the interests of
producing configurations that are likely to be valid over arange of hour angles, CONFIGURE
uses clearance parameters that are more constraining that those used by the actual positioner.
Y ou can change the clearance parameters, but only to the limiting values actually used by the
positioner.

The fibre clearance gives the number of microns that must be left clear each side of a fibre.
The button clearance gives the number of microns that must be left clear around a button.
Decreasing these will give the program more leeway to allocate fibres, but means that you
will need to be reasonably certain of the hour angle at which you intend to observe.

Note that if more than one spectrograph isin use a onceit isimportant to make sure that
enough sky fibres are allocated to each. This information can be obtained from the Select
Targets... option in the View menu.

Fibreto recover isan option that can be used explicitly to reallocate a specific fibre that was
originally allocated in away that has been deemed to be invalid.

Priority for bonustargetsis used only when the program operates in auto-reall ocate mode.
In this mode, it attemptsto re-allocate any fibres that were originally allocated in a way now
deemed invalid. It will treat any target with a priority less or equal to that specified as a
‘bonus’ target which can be discarded without serious loss in order to allocate the free fibres
to higher priority targets.

Lowest Fibre for Sky, Highest Fibre for Sky are used to limit the range of fibres that may
be alocated to sky positions during the automatic allocation phase. This could be useful for
example, if you wanted to ensure that all of your sky positions were recorded on the centre of
the CCD chips. The "only allocate sky" option ignores these values.
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11 Appendix A: A tour of CONFIGURE

Y ou should try this out using the test configuration file supplied with the program. A number
of test files are supplied with the configuration. For your first tour through the program, you
should use the supplied file 2dF _Test_1.fld. This is a fairly typica input file. This section
may seem quite long, but that is mainly because it has a lot of screen shots in it. Actualy
running through the tour should only take a few minutes.

11.1 Starting up

The configuration program is invoked in the same way as any UNIX program, by typing its
path name and appending any necessary parameters. If the configuration program is in the
user’s default directory, all that is required is the command:

Jconfigure &

(The ./ prefix is needed because security-conscious users will not have the default directory in
their path, and the final & is because it is usually most convenient to run the program in the
background.)

On AAO systems, typically the command "2dfsoftware” will create aliases for various 2dF
software, including configure. This means that configure can be started with the simple
command "configure" from any desired directory.

When the program starts up, it displays an initial window allowing you to specify the
instrument to be used.

r -

ﬁ ﬂ f:j Configure Instrument Selector

i Flease select the Fibre Instmment to
E conflgure for
cancel | ‘ 2dF ! FLAMES | 6dF

Figure 12 Instrument selection dialogue

For the purposes of this demonstration, we assume you select 2dF. If you select 6dF things are
more or less the same, except for the details of the number of fibres and their location on the
plate. If you want to configure for the ESO FLAMES instrument, things are significantly
different (the program needs you to specify a VLT guide star, and there are complex issues
connected with the number of different fibre types available with FLAMES). Configure is
usually built specialy for FLAMES, in a version known as FPOSS, that only supports
FLAMES and which asits own version of this manual.

Click on the 2dF button. The program will configure itself for 2dF, and will display three
windows. There will be a main control panel (Figure 14) and a window that will eventually
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show a‘mimic’ display of the field plate with targets and fibres. Initially, this will just show a
number of concentric circles of varying radii (Figure 15). There will aso be a ‘basic
sequence’ window that is intended to guide you through the program (Figure 13).

Let's take a quick look at each of these windows, although at the moment they aren’t very
interesting.

‘8086 Basic sequence ]

Magnitude filter Input lists are not being filtered

Open Tile
Fibre comhination All fibres

Allocate No fibres allocated
Save as SDS file Not saved

Exit
>

Figure 13 The Basic Sequence Window

For straightforward use of CONFIGURE, you will be able to control the configuration
process amost entirely from the basic sequence window. The idea is that you press each of
the buttons down the left hand side of the window in sequence. That is what we will do first in
this tour of the program. Later we will look at some of the other options, using the menus in
the main control pandl..
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ee6 AAD Fibre Configuration - ZdF (09717/02) :
File View Options Commands Foom EWE 2 s I
Input File:
Field Hame:
UT Date: Time: |
Config Wavelength: 6000.00
Field Centre (J2000): RA: | Dec: |
Plate: |0 HA: | ZD: |
Allocation statistics Available targets
Fibre type Total Sky  Objects Unalloc Obhjects skies
Totals 0 0 0 0
Messages
11:51:38 Opened telescope model file ",-""Usersfksffpnssfsrc,-’ftdf‘distnl A
11:51:38 Opened telescope model file " /Users/ks/fposs/scc//tdFlines
11:51:38 Wew field plate 15 0O
11:51:41 Initial File:
o | = i
14

Figure 14 The control panel

The control panel contains a number of menus, and a large number of fields where
information can be displayed, together with a scrolling region at the bottom for messages.
Note that the fields are not editable, even though they might look like it.
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666 CONFIGURE

Configuring 2dF (AAT)

|

= P
Figure 15 Theinitial mimic display

The mimic display at present only shows two concentric circles. If you move the cursor over
these, the left part of the status bar at the top of the window will tell you what they are. The
blue circle marks the furthest out that a fibre can be placed. The black circle marks the pivot
circle —the point where the fibres emerge from their retractors around the field plate

11.2 Setting a magnitude filter

For files that have a large number of targets you will probably want to set a magnitude filter
to reduce the number of targets to a manageable number. This is not true of the
2dF_Test_1.fld test file, and traditionally is not true of most 2dF fields. (It is a feature that
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was introduced mainly for the ESO FLAMES instrument.) However, you may as well see
what it looks like.

Thisiswhere we start out through the basic sequence window. Click on the ‘magnitude filter’
button. Y ou will see a dialogue prompting you to set a magnitude filter range.

r .

86eA Magnitude Filter

Magnitude limits to apply to input
target lists

Magnitude filtering is OFF

Input lists are not being filtered

Magnitude range: to

Apply Clear | Close I

Figure 16 Magnitudefilter dialogue box

If you do want to set afilter, fill in the two entry boxes and click on the *Apply’ button. Once
you do that, the dialogue box changes to indicate the new settings. For the purposes of our
demonstration, you can just click the *Close' button.

11.3 Opening the data file

Now click on the ‘Open File' button in the basic sequence window. This will bring up afile
selection dialogue box. This will look something like this, depending on what files you have
in your directory:
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906 Fibre Configuration File )
Directory: fUsers/ks/fpossisrc e I
E] £2dF_Test_1.1d
E] MET fd
[E] M3201-00.1d
[E] tdf150.fd
E] wIt1.fd
] e

File name: [ZdF_Test 1.fd ‘ Open
Files of type: Ascii files (*.fld}) s | Cancel
i

Figure 17 Open file selection

Select 2dF_Test_1.fld and click on the Open button. Now things start to happen. The target
list in this file will be read in, optionally filtered by magnitude, and the program now has
something to display on the mimic window. Y ou will also notice that there is information at
last in the various fields of the main control panel.
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ee6 AAD Fibre Configuration - ZdF (09717/02) :
File View Options Commands Foom EWE 2 s I
Input FI|E:! fUsersiksffpossssrciZdF_Test 1.1ld
Field Mame:! Final Analysis Sources in ELAIS-51
UT Date:| 2002/07/07  Time: | 19:36:06
Confiy Wavelength:|  6000.00

Field Centre {.J2000): RA: ! 00 34 37.20 Dec: l -43 28 12.0

Plate: |0 Ha: | -00:00:00  zD: | 12n0:25
Allocation statistics Available targets

Fibre type Total sky  Objects Unalloc Obhjects skies
Guide 4 0 0 4 32 0
Spect 1 200 0 0 200 344 39
Spect 2 200 0 0 200 344 39

Totals | 404 0 0| 404

Messajjes

11:51:38 Opened telescope model file ";"Usersfksffpnssfsrn:fftdf'distnl:S
11:51:38 Opened telescope model file "/Users/ks/fposs/scc//tdFlines
11:51:38 Mew field plate 15 0O

11:51:41 Initial File:

13:55:38 UT set to 2002707707 19:36:06 to put field on meridian

) | iy

Figure 18 Control pane with file open

As shown above in Figure 18, the details of the field are now displayed in the main panel,
which will now show the number of targets, classified into ‘objects’, and ‘skies' ‘Sky’ targets
are any targets designated as sky, while ‘objects’ are anything else. Note that the available
targets section shows the number of targets that can be allocated to each type of fibre. Since
most program targets can be allocated to either spectrograph, you can tell that in the example
shown above there are actually 344 target objects, 39 sky target objects, and 32 possible
guide targets.
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Now that a configuration file has been read in, the targets are displayed in the mimic window,
and the fibre positions are drawn, as shown in Figure 19. Since no fibres are allocated as yet,
al the fibres are shown at their park positions, just inside the black circle on the mimic
display. A compass at the top-right of the display shows the East and North directions, and the
instrument is displayed in the top left corner. The orientation of the display is the default
orientation, with East to the top and North to the right.

The guide fibres are shown in green and the spectrograph fibres are shown in light blue for
spectrograph 2 and yellow for spectrograph 2. Broken fibres are shown in red. If you place the
cursor on top of afibre the fibre type, including the spectrograph to which it is connected, is
displayed in the top information bar of the mimic panel.

Note that other features of the mimic display, such as the meaning of the circles, are identified
in the same way by moving the cursor upon them. The information appears in the top
information bar.
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Configuring 2dF (8AT)

Figure 19 Mimic display with new field

11.4 Selecting the Fibre combination

By default, all fibre types will be included in the configuration. However, you can control this
if you want to. Click on the ‘Fibre combination’ button in the basic sequence window, and
the following dialogue will appear:
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r "I

B O ©  Select Abre Combination

Select fibre combination to configure...
Current combination is
All fibres
& Al fibres
. Guide fibres anly
. apectrograph fibres anly
« apectrograph 1 only
. opectrograph & only
. apectrograph 1 + guide fibres

we opectrograph £ + guide fibres

‘ Spply | Close
! —rr— b ——

Figure 20 Fibrecombination dialogue

Y ou can select one of the alowed combinations. For the moment, just leave the combination
set to ‘all fibres' and pressthe ‘close’ button.

If you do change the fibre combination, the mimic display will change once you hit the
‘apply’ button. All the fibres except for those of the type selected are removed from the
display, and the fibre colours change.

Now, we arein aposition to allocate fibres to targets

11.5 Performing the Allocation

Click on the *Allocate’ button in the basic sequence window. Y ou will get a dialogue box that
presents you with a number of options that can be used to control the details of the allocation
algorithm.
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o6 Allocation

Set Allocation Parameters and Hit OK to Allocate

by most crowded target
by hardest target

by straightest target
iterative target allocation
only allocate sky

Taryet selection

NP R A

never
Tentative deallocation

<

if fibres are unallocated

never

+ <

Fibre Uncrossing when allocation completed

~ UNcross only

Humber of Spect 1 fibres to assign to sky i21

Number of Spect 2 fihres to assign to sky EE1

0K | Close |

Figure 21 Allocation dialogue

If you accept the default options and click the OK button, the allocation process will begin. A
progress box will be displayed giving some indication of what is going on, and eventually the
allocation will be complete. As fibres are allocated, they are drawn in their new positions on
the mimic display, and the final result will look something like this:
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8o 6 fUsersfksifpossisrcizdF_Test 1.fld

r{"\.j if"‘" £

Figure 22 Allocation completed

And that’sit. Onefield allocated. Now all you have to do is save it, and that’s the next step in
the basic sequence.

11.6 Saving the allocation
Click on ‘Save as SDS' in the basic sequence window, and you get a standard file save

dialogue. The file name is generated automatically based on the input file name, but you can
changeit if you want to.

Click on the ‘save button, and the file will be written.
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r "I

868 Fibre Configuration 3D3 Output File

Directory: fUsers/ks/fpossisrc e | |

E] fpinsStatus.sds

E] sixdFconstants sds
E] tdF constants. sds
E] tdFdistortion . sds
E] tdFdistortiont sds
[E] tdFlineard.sds

[E] tdFlinear! .sds

I~ L~

File name: |[£dF_Test 1.s5d4 ‘ Save

Files of type: 3DS files (*.sds) i Cancel

Figure 23 SDSfile save dialogue

And that has completed a basic run through CONFIGURE. The basic sequence window
should now look roughly as follows:

806 Basic sequence :
Magnitude filter Input lists are not being filtered
Open file 7 {Users/ks/fpossfsrc/2dF Test 1sds
Fibre combination All fibres
Allocate 327 fibres allocated
Save as SDS file v SDSfile: /Users/ks/fposs/src/2dF Test 1.sds
Exit J

i

Figure 24 Basic sequence completed

Now you can exit the program using the ‘Exit’ button, or you can go back to the start and
perform anew configuration with anew input file.

11.7 Things not in the basic sequence

There are a couple of things you may want to do as a matter of course when you run
CONFIGURE, but which are not included in the basic sequence. One is to set the wavelength
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to be used, and the other is to check the range of hour angle for which the configuration is
vaid.

11.7.1 Changing the central wavelength

The program needs to know a wavelength to use when calculating the positions of the targets
on the field plate. If the wrong wavelength is used, then the dispersed images at significant
hour angles will result in the fibres getting the wrong portion of the light from the object. To
set the wavelength, we need to use one of the menus in the control panel.

Bring the control panel to the front, select the ‘Commands menu and select the ‘Set
wavelength...” item in the commands menu. A small dialogue appears:

r B

8eAa Set Wavelength

Set Configuration Wavelength
(3000-10000 Angstroms) to...

EO00.00 Angstroms

‘ Ok | Close |

Figure 25 Set wavelength dialogue

You can use this to set the configuration wavelength to the main wavelength of interest for
your observations. Note that the guide star positions are calculated on the basis of a different
wavelength based on the known characteristics of the guide fibres and their filters. The * Set
wavelength...” dialogue does not affect this guide star wavelength. Note that the units used
are Angstroms.

11.7.2 Checking Allocation Validity

The allocation process results in a fibre configuration which is valid a a single time.
However, small changes in the relative positions of objects as aresult of refraction and other
effects could make this configuration invalid at other times and different tel escope positions.
It is possible to change the Hour Angle using the Set HA.... option in the Commands menu,
and then check the validity of the allocation using Check Allocation, also in the Commands
menul.

When CONFIGURE creates configurations, it does so by default using a set of tolerances for
such things as button clearances that are more restrictive than those actualy used by the
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positioner. These have been chosen so that in all cases tested, a configuration was valid (ie
would not be rejected by the positioner) over more than a +/- 4 hour range in Hour angle. So
unless you intend to observe at truly extreme hour angles, you do not normally need to make
this check.

The Check over Range of HA... option in the Commands menu performs a check that a fibre
configuration remains valid over arange of dates and telescope hour angles. The check should
run through with Allocation OK reported in the message region for each position tested.
Occasionally one or two fibres or buttons that are OK at the zenith will cause collisions at
large hour angles. The simplest procedure is to manually reassign these as extra sky fibres,
although it is usually possible to manually adjust the configuration to preserve the target
allocation while removing the collisions. An option in the Check over Range of HA...
dialogue can be used to get CONFIGURE to attempt this reallocation automatically.

r "|

a ﬂ @ Checking Allocation

Check Validity of Allocation for...

Starting Date: Year: [2002 Month: (07 Day: |07
Number of Hights: b
Maximum H.A.: §4.III

_{ Attempt to reallocate invalid fibres

Ok Close I

Figure 26 HA validity check dialogue

Naturally, the configuration produced by the allocation sequence just worked through passes
this default check. To illustrate a failure a configuration was generated using the actual
positioner tolerances rather than the larger tolerances normally used by CONFIGURE. Now
there is one rogue fibre that is positioned rather close to a button and at extreme hour angle
values moves just close enough to be counted as a collision. If you run the validity test you
get:
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r

0086 Error {Configure) 2

€ Button/fibre collision in target field (but=258 fib=255)
Target field configuration is INVALID - 1 error(s) detected

Ok | Clear All |

Figure 27 Hour angletest fails

By running the cursor over the fibres, you can easily pick up fibres 258 and 255, and you can
see that the button on fibre 258 is indeed allocated rather closely to fibre 255. The easiest
thing to do is click on fibre 258 then select the ‘Deallocate fibre command from the
commands menu. If you run the test with the ‘attempt to reallocate invalid fibres' button
checked this has the same effect.

12 Appendix B —Bug reporting

No program is perfect, and you may find bugs in CONFIGURE. If you do, please report them
to Chris Ramage, at AAO (cr@aaocbn.aao.gov.au). Do, please, include as much detail as
possible. Bear in mind that most aspects of CONFIGURE have been tested and found to work
on the test fields and operations tried on them. If you have hit a bug, you have probably got
something unusual in your input data or in the sequence of operations you attempted. (It may
not seem unusual to you, but if it induces a problem then it probably is something that has not
been attempted during testing at AAQO.) Generaly any bug that can be reproduced can be
fixed reasonably easily, so the important thing is to include as much detail as is needed to
reproduce the bug. In many cases, this means supplying the input .fld file in question, and a
description of just what sequence of operations caused the problem to show.
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